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Animate a digital story. 

Inspire writers to use their imaginations for storytelling. 

In this course, students create a digital story in the style of a cartoon or animated comic strip 

using Microsoft PowerPoint. To start, they learn about writing conventions and watch sample 

stories as a source of inspiration. Students then apply their creativity to construct their story with 
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Copyright © 1993 – 2024 TechnoKids Inc. 

All Rights Reserved 

This is a preview. The number of pages is limited. Some pages are omitted. 

TechnoToon is available for PowerPoint and Slides. 

https://www.technokids.com/store/elementary-school/technotoon/digital-storytelling.aspx 



  Contents 

Copyright © TechnoKids Inc.  TechnoToon | Microsoft 365 

Table of Contents 

Introduction 

Introduction .............................................................................................................................................. i 
TechnoToon Overview ............................................................................................................................ ii 
TechnoToon Course Outline ................................................................................................................. iv 
Technology Integration Ideas ............................................................................................................... v 

Session 1 Become a Digital Storyteller 

Session 1 Become a Digital Storyteller .................................................................................................. 1 
Assignment 1 Digital Storytelling, Cartoons, & Comic Strips .............................................................. 2 

What Is a Digital Story? .................................................................................................................... 2 
What Is a Cartoon or Comic Strip?................................................................................................. 2 

Assignment 2 View Sample Digital Stories ............................................................................................ 4 
Study Digital Stories .......................................................................................................................... 4 

Session 2 Plan a Digital Story 

Session 2 Plan a Digital Story .................................................................................................................. 5 
Assignment 3 Organize Story Ideas for the Digital Story ..................................................................... 6 

Pick a Story Idea ............................................................................................................................... 6 
Sketch Your Ideas ............................................................................................................................. 7 

Assignment 4 Make the Title Slide ......................................................................................................... 8 
Open PowerPoint and Create a New Presentation .................................................................... 8 
Add Story Title and Author to Slide ................................................................................................. 8 
Apply a Slide Background ............................................................................................................... 8 
Format the Text ................................................................................................................................. 9 
Format the Font Size ....................................................................................................................... 10 
Format the Font Style ..................................................................................................................... 10 
Format the Font Color .................................................................................................................... 10 
Apply a Shape Style to a Text Box ................................................................................................ 11 
Format the Fill Color of a Text Box ................................................................................................ 11 
Format the Outline of a Text Box .................................................................................................. 11 
Use Skills to Complete the Title Slide ............................................................................................. 12 
Close PowerPoint............................................................................................................................ 12 

Session 2 Extension Activity: Generate a Story Idea ......................................................................... 13 

Session 3 Set the Scene 

Session 3 Set the Scene ........................................................................................................................ 14 
Assignment 5 Set the Scene ................................................................................................................ 15 

Open the Digital Story in PowerPoint ........................................................................................... 15 
Add a New Slide and Apply a Layout ......................................................................................... 15 
Introduce the Story Using a Text Box ............................................................................................ 15 
Resize, Move, or Rotate a Text Box .............................................................................................. 16 
Add a Picture as the Slide Background ...................................................................................... 16 
Insert Character .............................................................................................................................. 17 
Draw a Callout to Make the Character Speak or Think ............................................................ 17 
Use Skills to Complete the Slide .................................................................................................... 18 
Save and Close PowerPoint .......................................................................................................... 18 

Session 3 Extension Activity: Use Images from the Internet .............................................................. 19 

Session 4 Illustrate the Comic Strip 

Session 4 Illustrate the Comic Strip ...................................................................................................... 21 



Contents 

Copyright © TechnoKids Inc. TechnoToon | Microsoft 365 

Assignment 6 Create the Action Scenes ........................................................................................... 22

Open the Digital Story in Microsoft PowerPoint .......................................................................... 22

Add a New Slide and Apply a Layout ......................................................................................... 22

Insert an Object .............................................................................................................................. 22

Emphasize an Action or Sound Effect Using WordArt ................................................................ 23

Draw a Starburst ............................................................................................................................. 24

Adjust the Object Order ................................................................................................................ 24

Group the WordArt and Starburst ................................................................................................ 24

Use Skills to Complete Remaining Slides ...................................................................................... 24

Session 4 Extension Activity: Picture Editing Workshop ..................................................................... 25

Session 5 Animate the Story Action

Session 5 Animate the Story Action .................................................................................................... 28

Assignment 7 Add Transitions and Animations .................................................................................. 29

Open the Digital Story in Microsoft PowerPoint .......................................................................... 29

Add a Transition Between Slides ................................................................................................... 29

Animate Objects ............................................................................................................................ 30

Reorder Animation ......................................................................................................................... 30

Play the Digital Story ...................................................................................................................... 30

Complete the Digital Story ............................................................................................................ 30

Session 5 Extension Activity: Animation Workshop ............................................................................ 31

Session 6 Share the Digital Story

Session 6 Share the Digital Story .......................................................................................................... 34

Assignment 8 Digital Story Checklist ................................................................................................... 35

Open the Digital Story in Microsoft PowerPoint .......................................................................... 35

Watch the Digital Story .................................................................................................................. 35

Complete the Checklist ................................................................................................................. 35

Close PowerPoint............................................................................................................................ 35

Assignment 9 Share Your Digital Story ................................................................................................ 36

Set Your Story to Automatically Play ............................................................................................ 36

Options for Sharing the Digital Story ............................................................................................. 36

Be a Peer Editor (Optional) ........................................................................................................... 37

Session 6 Extension Activity 1: Print Your Comic ................................................................................ 38

Session 6 Extension Activity 2: Make a Video .................................................................................... 39

Appendices

Appendices ........................................................................................................................................... 40

Appendix A: Assessment Tools ............................................................................................................ 41

TechnoToon Skill Summary ............................................................................................................ 41

Digital Story Marking Sheet............................................................................................................ 43

Appendix B: Contact Information ...................................................................................................... 44



 

 

 

Introduction 

 

Introduction 

 

This section provides valuable information about teaching TechnoToon. It 

includes an overview of the course. In addition, there are ideas for 

implementation and technology integration. 

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

 

TechnoToon Overview 

TechnoToon Course Outline 

Technology Integration Ideas 
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TechnoToon Overview 

Inspire writers to use their imaginations for storytelling. 

In this course, students create a digital story in the style of a cartoon or 

animated comic strip using Microsoft PowerPoint. To start, they learn 

about writing conventions and watch sample stories as a source of 

inspiration. Students then apply their creativity to construct their story 

with text boxes, images, callouts, starbursts, and shapes. Transitions are 

inserted between slides to divide the scenes. Animation is applied to 

objects to sequence the timing of events. Upon completion, the digital 

story is shared with peers. Challenging extension activities support 

learning with optional assignments such as picture editing, advanced 

animation techniques, or print options. Discover the fun your students 

can have with PowerPoint! 

Students complete the following tasks: 

➢ In Session 1, students become digital storytellers. They explore the genre by

examining how elements such as text boxes, callouts, shapes, and basic images

are combined to tell a narrative. To inspire their creativity, they view sample

cartoons created using Microsoft PowerPoint. These include "What is It?", "My

Dream", and "Super Dog". Each of these examples offers a distinct and innovative

approach to digital storytelling."

➢ In Session 2, students develop a plan for their digital story. They sketch their ideas

into a storyboard to arrange the sequence of events. An optional activity offers

suggestions for characters, settings, and plots. Once prepared, students use

Microsoft PowerPoint to craft their front cover. By experimenting with background

options including color, gradient fills, textures, and patterns, they discover how to

create a cartoon aesthetic. Following this, they explore formatting options to

produce a title with a text box featuring a unique outline and shape effect. These

graphic design skills will be applied in upcoming sessions to illustrate each scene

in their story.

➢ In Session 3, students begin by introducing the story to viewers. They create a slide

with a text box that describes what is happening. They select an online picture for

their slide background, setting the scene for their narrative. Suggestions are

provided to help them search for an ideal image. Next, they then choose their

main character, who will use a callout to speak. An optional activity explains how

to save a picture from the Internet to find a specific clipart for their character in

the story.

➢ In Session 4, students illustrate each scene in their story. To start, they learn how to

arrange object order and group shapes. They apply these graphic design

techniques to combine WordArt with shapes to depict sounds like splat, whoosh,

thud, or ka-pow. This makes their cartoon look authentic. As an optional activity,

students can further their understanding of picture editing by exploring advanced

styling, rotation, and cropping features.

➢ In Session 5, students animate each scene in their story. First, they apply transitions

between slides to divide the action between each strip of the comic. Then,

students animate individual slide objects to sequence storytelling. They are

guided with animation tips. An optional activity introduces advanced animation

techniques, such as combining entrance, emphasis, and exit effects, as well as

adjusting the order and timing of events.
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➢ In Session 6, students present their digital story to an audience. To prepare, they 

use a checklist to review the content, design, and animation. After completing 

revisions, students set their cartoon to play automatically. They then participate in 

a toon-a-thon, where the entire class watches each other's cartoons. Optional 

activities explain how to print the slides for assembly as a comic book and 

convert the file to a video. 
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TechnoToon Course Outline 

Purpose: Engage in digital storytelling. Produce 

a cartoon or animated comic strip that tells a 

story using text, imagery, and animation. 

Preparation: 

• Install Microsoft 365

• Share Toon folder with students

• Download Flashcards and Tool Summary from

TechnoHub (optional)Objectives: (see Appendix A: Skill Summary) 

• examine digital stories

• select and organize story ideas

• produce an original digital story

• revise a story to improve quality

• publish a digital story to share with others

• insert new slides and select layout

• format slide background for story backdrop

• express ideas using text and shapes

• illustrate events with images and objects

• divide story action by applying transitions

• animate slide objects to sequence events

• set a digital story to play automatically

Materials: 

• Assessment: Digital Story Checklist, Peer Editing

Checklist, TechnoToon Skill Summary, Digital

Story Marking Sheet

• PowerPoint Samples: What is It; My Dream,

Super Dog, Connection, PSA, Biography

• Parent Letter and Certificate (optional)

• Flashcards and Tool Summary (optional)

• Toon folder:

o Videos: What is It; My Dream, Super Dog

o Cartoon1 and Cartoon 2 (optional)

o Organize Story Ideas.pdf (optional)

Summary of Activities: 

• Learn about digital storytelling, cartoons, and comic strips. Complete storyboard panels.

• View sample digital stories as a source of inspiration. Answer questions about their content.

• Use a planning sheet to draft story ideas. Organize events into panels.

• Make a title slide. Format text and text boxes. Apply a slide background.

• Set the scene. Create a slide with a picture background. Include a text box, character, and callout.

• Create the remaining scenes. Include a starburst with text to emphasize an action.

• Add transitions to divide scenes. Animate objects to control the timing of events and enhance story.

• Complete a digital story checklist. Make revisions.

• Share a digital story.

Extension Activities: 

• Generate a Story Idea: Select a character, setting, and plot to generate a storyline.

• Use Images from Internet: Learn about copyright. Save a background or WordArt. Insert onto slide.

• Picture Editing Workshop: Crop, frame, and flip images.

• Animation Workshop: Practice animation techniques by making a short story.

• Print Your Comic: Print a handout with customized settings.

• Make a Video: Output the digital story as a movie file.

Assessment: 

• Self-Evaluation (Digital Story Checklist)

• Peer-Evaluation (Peer Editing Checklist)

• Teacher Evaluation (TechnoToon Skill Summary, Digital Story Marking Sheet)

Notes: 

• Digital storytelling is a language arts activity. Activities follow the stages of the writing process.

• The creative writing assignment can be kept simple. Use extension activities to challenge students

with advanced skills.

https://technohub.technokids.com/
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Technology Integration Ideas 

Inspire reluctant writers with digital storytelling. The TechnoToon course integrates technology 

into language arts. Have your students use their imaginations to create a story that looks like a 

cartoon or animated comic strip. This is a fun creative writing activity that students will enjoy. 

 

TechnoToon can be used as a creative writing unit, an option for a book report, or as part of a 

novel study. Here are a few ideas! 

• Write an Original Story: Plan a story or simple scenario that has a beginning, middle, and 

end. Divide the action into panels. Use text boxes to describe the scene, callouts for 

characters to speak or think, and clip art to illustrate the action. (see What Is It sample) 

• Only a Dream: Create a dream sequence that shows a series of imaginary scenes. This is 

an easy way to plan a digital story. (see My Dream sample) 

• Illustrate a Wacky Scene: Have fun with a cliché or popular expression. Make a simple 

scene that explains what happens when pigs fly, there is a blue moon, or it starts raining 

cats and dogs. 

• Invent a Superhero: Create a character and give them a name and superpower. Have 

the hero save the day! Take part in a rescue mission, engage in an epic battle with a 

powerful foe, stop a crook, or retrieve a lost item. (see Super Dog sample) 

• Tell a Joke: Make people laugh! Use one slide to make a silly scene, two slides to show 

before and after clips, or several slides to tell a knock-knock joke. 

• Transform a Popular Story: Remake a nursery rhyme or fairy tale into a cartoon. Swap the 

characters, adjust the story line, or rewrite the ending to create a modern twist on an old 

favorite. 

• Retell a Story: Summarize the main parts of a story. Sequence the key events using slides 

as scenes. In the first scene introduce the characters and setting. The following slides 

illustrate the action.  

• Rewrite the Ending: Produce an animated scene that illustrates a different ending. 

Include a slide that explains why this ending is better than that of the author. 

• Makeover a Realistic Story into a Cartoon: Consider what a story would be like if the 

people were substituted for cartoon characters, the setting shifted to an imaginary 

place, but the plotline remained similar. Create a short, animated clip of the cartoon 

version. 

• Join the Action: Insert yourself into the story. What advice would you share? How would 

you help? Recreate a scene from the story. Use a clip art character, photo, or web cam 

image to put yourself into the scene. Does your advice or behavior change the ending? 

• Form a Connection: Reflect on the story. What connection do you have? Do you like the 

same things as the main character, have you shared a similar experience, or does the 

story remind you of something you have seen or read? Explain the connection and use 

evidence from the book or your life to support your ideas. (see connection sample) 

• Conduct a Character Analysis: How does the character change as the story unfolds? 

Create a three-panel animated comic strip. In the first panel introduce the character at 

the beginning of the story. Use callouts and textboxes to show their mood, describe their 

character traits, and explain their role within the story. In the second panel illustrate an 

important event that causes a change or growth within the character. In the final panel 

show the character at the end of the story. How are they different? 
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Great news! You can integrate the use of cartoons or animated comic strips into health, social 

studies, history, or science. These are excellent ideas to encourage your students to transfer their 

skills. 

• Design a Public Service Announcement: Raise awareness about an important issue.

Educate the public about safety, nutritious eating, or school initiative. Make a simple

cartoon strip that highlights important information. (see PSA sample)

• Report the Facts: Create an animated series called Did You Know? Each slide includes

facts about a topic.

• Explain How-To: Present steps in a sequenced logical manner. Write instructions to

demonstrate how to complete a task.

• Produce an Animated Biography: Report about a famous person. Summarize important

details, significant events, and explain how they contributed to society. Use photographs

or clip art, combined with callouts, and/or starbursts to create a first-person account.

(see biography sample)

• Highlight a Historical Moment: Reveal what historical figures were thinking at the time a

famous photo was taken. Add callouts or think bubbles to show dialog or express a

thought.

• Recap Historical Events: Organize events into an animated timeline. Select several key

moments and explain their historical importance.



 

 

 

Session 1 Become a Digital Storyteller 

 

Session 1 
Become a Digital 
Storyteller 

 

In this session, students become digital storytellers. They explore the genre by 

examining how elements such as text boxes, callouts, shapes, and basic 

images are combined to tell a narrative. To inspire their creativity, they view 

sample cartoons created using Microsoft PowerPoint. These include "What is 

It?", "My Dream", and "Super Dog". Each of these examples offers a distinct 

and innovative approach to digital storytelling." 

 

Assignment 1: Digital Storytelling, Cartoons, & Comic Strips 

Assignment 2: View Sample Digital Stories 

 



This is a preview of the teacher guide. 

Pages have been omitted. 
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Assignment 2 View Sample Digital Stories 

   

 

Study Digital Stories 

 Open the Toon folder. 

View each sample and answer the questions. 

1. You can create a simple digital story using Microsoft PowerPoint with only a few images.  

Watch What Is It.  

 

 

     
 

 Finish the story differently. What else could have been in the box? 

  

 

 

2. Making a digital story is fun because you can use your imagination. With only a few 

images and simple animation you can make a story come to life. Watch My Dream.  

 

 

       
 

 What other things could you dream about that would make you happy? 

  

 

 

3. In a digital story, characters can be made to move and talk. Callouts help to tell the 

story. Watch Super Dog.  

 

 

    

 

 

 What character could you use for a super hero? What would be their super power? 

  

 

 

 

Watch 

digital 

stories. 

Each story was made using 

Microsoft PowerPoint. 

Get ideas for 

your own story! 
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Session 2 
Plan a Digital Story 

 

In this session, students develop a plan for their digital story. They sketch their 

ideas into a storyboard to arrange the sequence of events. An optional 

activity offers suggestions for characters, settings, and plots. Once prepared, 

students use Microsoft PowerPoint to craft their front cover. By experimenting 

with background options including color, gradient fills, textures, and patterns, 

they discover how to create a cartoon aesthetic. Following this, they explore 

formatting options to produce a title with a text box featuring a unique outline 

and shape effect. These graphic design skills will be applied in upcoming 

sessions to illustrate each scene in their story. 
 

Assignment 3: Organize Story Ideas for the Digital Story 

Assignment 4: Make the Title Slide 

 

Session 2 Extension Activity: Generate a Story Idea 
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Session 2 Extension Activity: Generate a Story Idea 

   

 

My Story Idea: 

 

Character Setting Event 

alien or monster jungle or woods holiday 

dinosaur ocean curse or spell 

robot planet explosion 

pirate tomb top secret mission 

superhero or villain temple or pyramid robbery 

unicorn cave disappearance 

genius castle escape 

mummy parallel universe time travel 

witch or wizard desert discovery 

spy north pole kidnapping 

vampire mountain party 

knight maze cure or virus 

 

Spark your imagination! Pick an adjective to describe your character or setting. 

brave ugly lazy invisible mythical 

jolly charmed weird shrinking frozen 

evil cryptic far away talking spooky 

 

Need more ideas? Pick a gadget or object to include in your story. 

doomsday ray teleporter freeze machine relic or amulet serum 

wand scroll mask spaceship sword or dagger 

Need an 

idea? 

Pick a character, 

setting, and event. 

Use them to think 

of a story idea. 



Session 3 Set the Scene 

Session 3 
Set the Scene

In this session, students begin by introducing the story to viewers. They create a 

slide with a text box that describes what is happening. They select an online 

picture for their slide background, setting the scene for their narrative. 

Suggestions are provided to help them search for an ideal image. Next, they 

then choose their main character, who will use a callout to speak. An optional 

activity explains how to save a picture from the Internet to find a specific 

clipart for their character in the story. 

Assignment 5: Set the Scene 

Session 3 Extension Activity: Use Images from the Internet 
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Assignment 5 Set the Scene 

   

 

Open the Digital Story in PowerPoint  

 

 

Add a New Slide and Apply a Layout 

 Select the thumbnail of the first slide in the slide pane.  

 

 Click the New Slide arrow.  

 Pick Title Only.  

 
 

Introduce the Story Using a Text Box 

 Type inside the text box: 

 
 

 Format the font , size , style , ,  , , or color   of text. 

 From the Home tab, pick an alignment option.      

 From the Shape Format tab, set a text box style  , fill  , outline , or effect . 

  

You are going to 

make the first 

scene in your story. Refer to the 

planner you 

completed in 

Assignment 3. 

You will learn to 

insert images and 

make a callout. 

The Title Only layout has a 

text box that can be used 

to describe the scene. 
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Resize, Move, or Rotate a Text Box 

 Select the text box.

Edit the shape and position of the text box:

o Click and drag a handle IN or OUT to resize it.

o Click and drag on the border of the text box to move it.

o Click on the rotate handle and turn the mouse to change the angle.

Add a Picture as the Slide Background 

 Click the Design tab. Click Format Background.

 Select Picture or texture fill. Click Insert.

 Pick Online Pictures.

 In the search box, type background. Press ENTER.

 Refine the search using the Filter  options. 

 Find a picture you like. Click on it and then click Insert.

 Close the Format Background pane.

Search Word Tips: Use these words or combine them with a search word to find a background. Make the 

word plural to change the search results. 

gradient fabric pattern paper texture 

wall wood background wallpaper abstract 

design scene scenery nature fantasy 

landscape scape painting art summer 

dark or light night colorful free stock 

watercolor presentation sketch vector drawing 

rotate 

move resize 

The picture you pick 

should be WIDE. 

Refine the 

search. Click 

and choose 

options. 
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Insert Character 

 From the Insert tab, click Pictures.   Pick Online Pictures.  

 In the search box, type search word. Press ENTER.  

 Click Filter.  Select Clipart to find cartoon images.  

 

 Click on a character you like. Click Insert. 

 

 Use your skills to resize  and move  the character.  

 

Draw a Callout to Make the Character Speak or Think 

 From the Insert tab, click Shapes.  

From the Callouts category pick a shape.  

 

 Click and drag to draw a callout. 

 Click inside the callout. Type what the character is saying or thinking. 

 

 Rest the mouse over the yellow handle.  

Drag it to change the direction of the tail.  

 

 Use your skills to resize   and place  the callout. 

 Click the Shape Format tab. Apply a style , fill , outline , or effect .  

What is your character saying or thinking? 

If your character has a colored 

background, from the Picture 

Format tab, click Color  . 

Click Set Transparent Color . 

Click the colored background. 
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Use Skills to Complete the Slide 

 Complete the first scene in your story.

 Use text boxes and callouts to explain what is happening.

 Use your skills to create the scene.

Save and Close PowerPoint 

Story Making Tips: 

✓ Any shape  can have text added. 

✓ Use Pictures  and pick Online Pictures  to add objects 

to the scene.

✓ Use the text box to describe the action.

✓ Show your scene to a friend. Is there enough information to

understand what is happening?

✓ Copy  (CTRL + C) and paste  (CTRL + V) objects to quickly 

make a scene. 

Complete Session 3 Extension 

Activity to learn how to save 

pictures from the Internet to 

use in your cartoon. 
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Session 6 
Share the Digital Story

In this session, students present their digital story to an audience. To prepare, 

they use a checklist to review the content, design, and animation. After 

completing revisions, students set their cartoon to play automatically. They 

then participate in a toon-a-thon, where the entire class watches each other's 

cartoons. Optional activities explain how to print the slides for assembly as a 

comic book and convert the file to a video. 

Assignment 8: Digital Story Checklist 

Assignment 9: Share Your Digital Story 

Session 6 Extension Activity 1: Print Your Comic 

Session 6 Extension Activity 2: Make a Video 
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Be a Peer Editor (Optional) 

Watch a digital story. 

Complete the checklist. 

Story Quality 

The title attracts attention and tells about the story. 

The scenes combine to create a story that is interesting and makes sense. 

Content and Design 

The images used for the characters are suitable for the story. 

Text boxes are used to describe the action. 

Callouts are used to express what the character is saying or thinking. 

Objects such as starbursts and WordArt emphasize the story action. 

Slide backgrounds provide a fitting backdrop for a scene. 

Animations and Transitions 

Transitions divide the scenes. 

Animations suit the object and enhance the story telling. 

The animations are sequenced in a logical order. 

Comments – List one thing you liked about the digital story. 
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Appendices

Refer to the appendices for additional resources: 

Appendix A: Assessment Tools 

TechnoToon Skill Summary 

Digital Story Marking Sheet 

Appendix B: Contact Information 
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Digital Story Marking Sheet 

Story Quality 

• The title attracts attention and tells about the story.

• The scenes combine to create an interesting story that makes sense.

• All scenes are created in the style of a cartoon or comic strip.

• Story idea is original.

• Story is free of spelling and grammar errors.

/10 

Content and Design 

• The images used for the characters are suitable for the story.

• Text boxes are used to describe the action.

• Callouts are used to express what the character is saying or thinking.

• Objects such as starbursts or WordArt emphasize the story action.

• Slide backgrounds provide a fitting backdrop for each scene.

/10 

Animations and Transitions 

• Transitions divide the scenes and add interest.

• Animations suit the object and enhance the story telling.

• Animations are sequenced in a logical order.

• The speed of animation is timed appropriately.

• Animation is creative.

/5 

Comments: 

/25 



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



Super Dog

Saves the Day!

by Super Hero



The bank in TechnoVille has just been robbed!

Mu-ha-ha that 
was so easy! 
They will never 
catch me.

Arff. Never fear! Super 
Dog is on the case. 
My super sniffer thinks 
he went that-a-way!



It is Barry the Burglar - a known crook! The chase is on!

Oh No! I think 
Super Dog is on 

to me!!

Arff! I am getting 
close. My super 
sniffer will find 

him.



Dagnabit, foiled again! 

I will escape you next 

time Super Dog!

Arff!

Crime does 
not pay!

Super Dog with his super 
sniffer saves the day!

CAP
TUR

ED!
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